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MATERI MANOVA SATU ARAH (EMPAT UJI) DAN POS HOC
	Pengertian MANOVA

	Multivariate analysis of variance (MANOVA) adalah perluasan dari analysis of variance (ANOVA) univariat. MANOVA digunakan untuk mengetahui pengaruh variabel independen kualitatif (dua atau lebih grup) terhadap dua atau lebih variabel dependen kuantitatif. Apabila hanya ada dua grup dan dua atau lebih variabel dependen kuantitatif maka gunakan uji Hotelling’s .


	Manova Satu Arah

	MANOVA satu arah adalah analisis varian multivariat yang digunakan untuk menguji ada atau tidaknya perbedaan yang nyata tentang pengaruh perlakuan terhadap p variabel respon (p>1), atau menguji kesamaan vektor rata-rata dari beberapa (k) populasi


Berikut keuntungan menggunakan MANOVA menurut Bray dan Maxwell (1985) dan Stevens (2002) adalah
1. Satu variabel dependen jarang menggambarkan seluruh fenomena yang diteliti. Beberapa variabel dependen lebih memperluas domain konseptual yang sedang dipelajari.
1. MANOVA memberikan kontrol terhadap level α secara keseluruhan.
1. Uji statistik univariat cenderung mengabaikan interkorelasi antara variabel dependen. Sedangkan MANOVA mempertimbangkan interkorelasi antar variabel dependen dengan memeriksa matriks varians-kovarians.
1. MANOVA memungkinkan peneliti untuk menguji hubungan antara variabel dependen pada setiap level variabel independen.
1. MANOVA memberi petunjuk statistik kepada peneliti tentang pereduksian jumlah variabel dependen.
1. MANOVA membantu mengidentifikasi variabel dependen yang menghasilkan perbedaan grup paling besar.
1. MANOVA dapat memperjelas adanya perbedaan grup dan meningkatkan power.
	Manova tidak Dpat digunakan :

	MANOVA tidak dapat digunakan ketika
1. Jika variabel-variabel dependen tidak berkorelasi. Situasi ideal penggunaan MANOVA jika variabel-variabel dependen berkorelasi moderat. Weinfurt (1995) menyatakan korelasi antar tiga variabel dependen berkisar antara 0.21 dan 0.36 cukup untuk MANOVA.
1. Jika variabel-variabel dependen berkorelasi sangat tinggi → multikolinearitas.
1. Keterbatasan pengetahuan statistik. Asumsi-asumsi dalam MANOVA lebih kompleks dibanding univariat.


A. Model Manova
Model MANOVA untuk perbandingan  vektor rata-rata populasi  ,  dan 
Dengan  adalah ventor galat acak . Vektor paramater  adalah rataan keseluruhan, dan  menyatakan pengaruh perlakuan ke- dengan .
Suatu vektor pengamatan dapat dikomposisi seperti pada model

B. Hipotesis
·  (Semua perlakuan memberi respon yang sama)
·  (terdapat 2 kelompok perlakuan memberi respon berbeda)
PERHITUNGAN DENGAN APLIKASI EXCEL
A. Statistik Uji Manova Satu Arah Dengan Aplikasi Excel
	Hipotesis

	: 
Minimal ada satu , dimana 


Menentukan Matriks B dan W
· Menyiapkan Data di Excel, seperti pada gambar berikut
[image: data1.png]
· Langkah berikut, menghitung rata-rata total dan rata-rata pervariabel dari data tersebut seperti pada gambar berikut
[image: data2.png]
· Berdasarkan gambar tersebut kita telah memperoleh Matriks B
· Berikut kita juga akan menentukan matriks W
· Untuk menentukan matriks W kita perlu menggunakan fitur Analysis Data Pada Excel untuk memudahkan kita membuat matriks kovarians dari masing-masing kelompok data.
· Klik menu File > Option pada aplikasi Microsoft excel, seperti pada gambar berikut !
[image: excel1.png]
· Selanjutnya klik sub Menu Add-ins, pada bagian kanan pilih Analysis Toolpack dan klik Go di bagian bawah.
[image: excel2.png]
· Selanjutnya, ceklis pada bagian Analysis Toolpack dan klik ok
[image: excel3.png]
· jika langkah di atas dilakukan dengan benar seharusnya sudah tampil sub Menu Data Analysis pada menu Data.
· Selanjutnya, akan ditentukan matriks kovarians dari kelompok Data Model Posed learning (1), Problem Base learning (2), dan Broject Base Learning (3) Secara berurut, Dengan terlebih dahulu memilih sub menu Data Analysis dari menu Data, kemudian mengikuti langkah seperti pada gambar berikut:
[image: excel40.png]
Pilih Covariance kemudian OK
[image: excel4.png]
· Klik icon sebagaimana ditunjukkan pada pointer nomor (1), kemudian block Data Y1 dan Y2 sepanjang daerah dari data Model Posed learning (kode 1) sebagaimana pointer nomor (2), Pilih Grouped By Column (3), Pilih Output Range(4), Klik icon untuk memilih cell untuk hasil output (5) dan (6), kemudian klik OK.
· ulangi langkah sebelumnya untuk data Model Problem base Learning (Kode 2), dan Projeck based Learning (kode 3), sehingga diperoleh hasil sebagaimana gambar berikut
[image: matriksw.png]
· selanjutnya, untuk menentukan Matriks W, menggunakan rumus =10*L6+10*L11+10*L16 di cell K22, cell yang tersisa diisi dengan copy-paste rumus pada cell K22, sehingga di peroleh Matriks W seperti pada gambar di atas
Uji Wilks Lambda
· Selanjutnya Menentukan Uji Wilks Lamda sebagaimana pada gambar berikut
[image: wilkslamda.png]
· berdasarkan gambar tersebut di peroleh nilai  > 
· selanjutnya, menentukan Uji Pillail, Uji lawly Hotelling, dan Uji Roy, terlebih dahulu harus di cari nilai Lambda Eigen. Dapat dilakukan dengan cara seperti gambar berikut
[image: lamda.png]
· Matriks  diperoleh dengan memilih range F58:G59 dan mengetik rumus determinan matriks =MINVERSE(F52:G53) diakhiri dengan menekan tombol kombinasi untuk fungsi array yaitu : CTRL+ SHIFT+ ENTER secara bersamaan.
· Matriks  diperoleh dengan memilih range F64:G65 dan mengetik rumus perkalian matriks =MMULT(F58:G59;F61:G62), diakhiri dengan menekan tombol kombinasi untuk fungsi array yaitu : CTRL+ SHIFT+ ENTER secara bersamaan.
· Untuk menentukan nilai  dengan permisalan 2, sebagai alat bantu untuk memnentukan determinan dari  dengan mengisi cell F70 dengan rumus berdasarakan persamaan  yaitu =F64-F69*F55, copy-paste rumus tersebut ke cell F71, G70, dan G71.
· selanjutnya kita menafaatkan fitur Goal Seek pada excel untuk mencari nilai lamda yang membuat persamaan  berlaku. Pilih menu Data > What-if Analysis dan Pilih Goal Seek seperti pada gambar berikut.
[image: goalseek.png]
· akan muncul kotak dialog, Isi kolom Get Cell dengan alamat cell determinan  yaitu $G$73, Kolom To cell dengan nilai 0, dan kolom By Changed Cell dengan alamat cell nilai Lambda () pada contoh ini $F$69.
· dari langkah tersebut diperoleh nilai , dengan melakukan percobaan kedua menggunakan Goal Seek dan nilai lambda awal = 1.5 diperoleh nilai .
Uji Bartlet Pillail
· menentukan Uji Bartlet Pillail seperti ditujukkan pada gambar di bawah ini
[image: pillail.png]
· Nilai 
· selanjutnya  diperoleh dengan rumus =(I82/(H79-I82)*(30-3-2+H79)/H80) pada cell F85 diperoleh 
· Berdasarkan hasil perhitungan tersebut  >  > Karena >, maka  ditolak, sehingga dapat disimpulkan terdapat dua kelompok perlakuan yang memberikan respon yang berbeda
Uji Roy
· Menentukan uji Roy diperlihatkan pada gambar berikut
[image: roy.png]
· untuk menentukan Uji ROy memilih nilai lambda yang terbesar yaitu : 0,584 dan menentukan  menggunakan rumus =((30-2-1)*F95)/2 di cell F103 diperoleh  dan  > Karena >, maka  ditolak, sehingga dapat disimpulkan terdapat dua kelompok perlakuan yang memberikan respon yang berbeda
Uji Lawly-Hotelling
· Uji Lawly_hotelling diperoleh dengan cara seperti pada gambar berikut
[image: lawly.png]
· Berdasarkan gambar tersebut , dimana  diperoleh  dan  > Karena >, maka  ditolak, sehingga dapat disimpulkan terdapat dua kelompok perlakuan yang memberikan respon yang berbeda
Pos Hoc Dengan Aplikasi Excel
Pengujian dengan Pos Hoc dalam Aplikasi Excel dapat dilakukan dengan uji Tukey dan memanfaatkan Fitur Data Analysis, 1. Pengujian Terhdapat Variabel Dependen Kemampuan Pemecahan Masalah (Y1) - siapkan data dalam format seperti pada gambar berikut
[image: poshoc1.png]
· Pilih Menu Data> Data Analysis dan Anova Single Factor kemudian OK
· Selanjutnya akan tampil hjendela seperti pada gambar di bawah ini
[image: poshoc2.png]
· Input seperti pada gambar di atas sesuai dengan urutan nomor pointer merah.
· jika langkah yang dilakukan benar akan tampil seperti pda gambar di bawah ini
[image: poshoc3.png]
· selanjutnya perlu dibuat tabel bantu dan perhitungan seperti pada gambar berikut
[image: poshoc4.png]
· Q diperoleh berdasarkan tabel
[image: tabelq.png]
· Nilai Q kritis untuk menjadi pembanding diperoleh dengan rumus =Q24*sqrt(P11/Q21) diperoleh nilai Q=6,507 seperti pada gambar di bawah ini
[image: poshoc5.png]
· selanjutnya membandingkan dengan Nilai Perbedaan rata-rata Setiap Model, Jika Nilai PAda Kolom N22,N23 dan N24 lebih besar dari nilai Q kritis maka perbedaan setiap pasangan kelompok Model pembelajaran sigifikan, menggunakan rumus IF pada cell N22 dengan rumus =IF(L22>M22,"Ya";"Tidak"), dengan copy-paste rumus pada cell N22 ke cell N23 dan N24 diperoleh hasil Bahwa Hanya Pasangan PL-PjBL yang menunjukkan perbedaan yang signifikan ditinjau dari Kemampuan Pemecahan Masalah (Y1)
1. Pengujian Terhdapat Variabel Dependen Kemampuan Berpikir Kritis (Y2)
· Dengan melakukan cara yang identik dengan Pengujian variabel Y1 diperoleh hasil sepertipda gambar berikut
[image: poshoc6.png]
Berdasarkan hasil Uji Tukey sebagaimana pada gambar di atas tidak terdapat perbedaan signifikan antara Model Pembelajaran PL dengan PBL, PL dengan PjBL dan antara PBL dengan PjBL ditinjau dari Kemampuan berfikir siswa (Y1).
PERHITUNGAN DENGAN APLIKASI R
A. Statistik Uji Manova Satu Arah Dengan Aplikasi R
	Hipotesis

	: 
Minimal ada satu , dimana 


	Kriteria Pengujian

	· Tolak  jika nilai dari  atau P-value > 
· terima  jika hasil  atau P-Value < dari  atau 


Uji MANOVA dengan Aplikasi R
Siapkan data excel DataManova.xls yang terdiri dari 3 Kolom yaitu Model, Y1, dan Y2, dimana kolom Model Berisi data kategori yang terdiri dari 3 kelompok (PL,PBL, dan PjBL) Model Pembelajaraan yang akan diuji (Variabel Independen), kolom Y1 berisi data Numerik (Variabel Dependen) tentang kemampuan pemecahan masalah, dan Kolom Y2 berisi data Numerik (Variabel dependen) tentang Kemampuan Berpikir Kritis siswa (Y2). Pada cpntoh ini Data yang akan diimport berada di Sheet2 - buka aplikasi R-studio - buka file R script baru dengan menekan CTRL-SHIFT-N - kemudian klik icoon Import Dataset > From Excel seperti pada gambar berikut! [image: r1.png]
· Selanjunya klik Browse untuk mencari dan memilih file DataManova.xlsx yang telah disiapkan sebelumnya [image: r2.png]
· selanjutnya pada bagian sheet ubah menjadi Sheet2 karena data berada di Sheet2 dan pastiken For rows as names terceklis, kemudian pilih import [image: r3.png]
· jika dilakukan dengan benar akan tampil seperti pada gambar berikut
[image: r4.png]
· ketikkan kode sintaks berikut pada R script
## Mengimport Data
library(readxl)
DataManova <- read_excel("DataManova.xlsx",sheet="Sheet2",    # Tidak digunakan ketika menggunakan cara import
                         col_names=TRUE)
## Mengecek Data
DataManova
y1 <- DataManova$Y1
y2 <- DataManova$Y2
x <- DataManova$Model
## Uji Manova
library(car)
ujiM<-lm(cbind(y1,y2)~Model,DataManova)
HasilUji<-Manova(ujiM)
summary(HasilUji,multivariate=TRUE)
Line 6
Menampilkan isi DataManova
Lines 7-8
Mendefinisikan y1, dan y2, masing-masing sebagai nilai dari DataManova pada kolom Y1 dan Y2
Lines 9,11
Mendefinisikan x sebagai nilai adri Kolom Model pada DataManova
Line 12
Mengaktifkan library Car agar dapat menggunakan fungsi lm dan Manova
Line 13
Mendefinisikan ujiM sebagai hasil dari fungsi lm (linear model).
Line 14
Mendefinisikan HasilUji sebagai hasil dari fungsi Manova
# A tibble: 30 × 3
   Model    Y1    Y2
   <chr> <dbl> <dbl>
 1 PL       88    79
 2 PL       77    87
 3 PL       87    69
 4 PL       86    88
 5 PL       92    77
 6 PL       76    75
 7 PL       83    88
 8 PL       72    79
 9 PL       90    80
10 PL       94    90
# ℹ 20 more rows

Type II MANOVA Tests:

Sum of squares and products for error:
      y1     y2
y1 917.5  -50.3
y2 -50.3 1106.1

------------------------------------------
 
Term: Model 

Sum of squares and products for the hypothesis:
         y1    y2
y1 289.8667 260.4
y2 260.4000 304.2

Multivariate Tests: Model
                 Df test stat approx F num Df den Df    Pr(>F)   
Pillai            2 0.4019395 3.395481      4     54 0.0150370 * 
Wilks             2 0.6103414 3.640138      4     52 0.0109074 * 
Hotelling-Lawley  2 0.6183058 3.864411      4     50 0.0082096 **
Roy               2 0.5838419 7.881866      2     27 0.0020132 **
---
Signif. codes:  0 '***' 0.001 '**' 0.01 '*' 0.05 '.' 0.1 ' ' 1
4. Hasil Uji Manova Dengan 4 Uji
· Uji Wilks Lambda Nilai wilks Lambda 3,64 dengan nilai signifikansi 0.01091 <  (0.05) sehingga tolak 
· Uji Pillai Nilai Trace Pillai 3,395 dengan nilai signifikansi 0.01504 <  (0.05) sehingga tolak 
· Uji Hotelling-Lawley Nilai Trace Pillai 3,864 dengan nilai signifikansi 0.00821 <  (0.05) sehingga tolak 
· Uji Akar Maksimum Roy Nilai Akar Maksimum Roy 7,881 dengan nilai signifikansi 0.002013 <  (0.05) sehingga tolak 
5. Kesimpulan
Dapat disimpulkan bahwa dengan tingkat kesalahan 5% intervensi Model pembelajaran PL, PBL, dan PjBL memberikan hasil yang berbeda terhadap kemampuan Pemecahan Masalah dan Kemampuan berpikir kritis siswa.
B. Uji Pos Hoc dan Interval Kepercayaan
# Uji Tukey
ujiTukey_y1<-TukeyHSD(aov(y1~x,data=DataManova))
ujiTukey_y2<-TukeyHSD(aov(y2~x,data=DataManova))
print("Ini Hasil Uji Tukey y1")
ujiTukey_y1
print("-------------------------------")
print("Ini Hasil Uji Tukey y2")
ujiTukey_y2

# UJi T Pairwise T Test
UjiPair_y1 <- pairwise.t.test(y1,x,p.adjust.method = "bonf")
UjiPair_y2 <- pairwise.t.test(y2,x,p.adjust.method = "bonf")
UjiPair_y1
UjiPair_y2

# Uji LSD
library(agricolae)
ujiLSD_y1<- LSD.test(aov(y1~x,data=DataManova),'x')
ujiLSD_y2<- LSD.test(aov(y2~x,data=DataManova),'x')
ujiLSD_y1
ujiLSD_y2
Line 2
Mendefinisikan UjiTukey_y1 sebagai hasil Uji Tukey untuk Variabel Y1
Line 3
Mendefinisikan UjiTukey_y2 sebagai hasil Uji Tukey untuk Variabel Y2
Line 4
menampilkan kalimat “Ini hasil uji Tukey y1”
Line 5
menampilkan Hasil Uji Tukey untuk Variabel Y1
Line 11
Mendefinisikan UjiPair_y1 sebagai hasil Uji Pairwise T Test untuk variabel Y1 dengan Uji Bonferoni
Line 18
Mendefinisikan UjiLSD_y1 sebagai hasil Uji LSD untuk variabel dependen Y1
[1] "Ini Hasil Uji Tukey y1"
  Tukey multiple comparisons of means
    95% family-wise confidence level

Fit: aov(formula = y1 ~ x, data = DataManova)

$x
         diff       lwr       upr     p adj
PjBL-PBL -3.4 -9.863769  3.063769 0.4051335
PL-PBL    4.2 -2.263769 10.663769 0.2583469
PL-PjBL   7.6  1.136231 14.063769 0.0187465

[1] "-------------------------------"
[1] "Ini Hasil Uji Tukey y2"
  Tukey multiple comparisons of means
    95% family-wise confidence level

Fit: aov(formula = y2 ~ x, data = DataManova)

$x
         diff       lwr       upr     p adj
PjBL-PBL  0.3 -6.797085  7.397085 0.9939637
PL-PBL    6.9 -0.197085 13.997085 0.0579086
PL-PjBL   6.6 -0.497085 13.697085 0.0720649


    Pairwise comparisons using t tests with pooled SD 

data:  y1 and x 

     PBL   PjBL 
PjBL 0.610 -    
PL   0.356 0.021

P value adjustment method: bonferroni 

    Pairwise comparisons using t tests with pooled SD 

data:  y2 and x 

     PBL   PjBL 
PjBL 1.000 -    
PL   0.069 0.087

P value adjustment method: bonferroni 
$statistics
   MSerror Df     Mean       CV  t.value      LSD
  33.98148 27 80.56667 7.235454 2.051831 5.349062

$parameters
        test p.ajusted name.t ntr alpha
  Fisher-LSD      none      x   3  0.05

$means
       y1      std  r       se      LCL      UCL Min Max   Q25  Q50   Q75
PBL  80.3 4.547282 10 1.843407 76.51764 84.08236  76  88 76.25 79.0 84.00
PjBL 76.9 5.237684 10 1.843407 73.11764 80.68236  68  85 74.25 77.0 80.25
PL   84.5 7.337120 10 1.843407 80.71764 88.28236  72  94 78.50 86.5 89.50

$comparison
NULL

$groups
       y1 groups
PL   84.5      a
PBL  80.3     ab
PjBL 76.9      b

attr(,"class")
[1] "group"
$statistics
   MSerror Df Mean       CV  t.value     LSD
  40.96667 27 76.7 8.344877 2.051831 5.87316

$parameters
        test p.ajusted name.t ntr alpha
  Fisher-LSD      none      x   3  0.05

$means
       y2      std  r       se      LCL      UCL Min Max   Q25  Q50   Q75
PBL  74.3 4.473378 10 2.024022 70.14705 78.45295  67  80 71.25 75.0 77.00
PjBL 74.6 7.501111 10 2.024022 70.44705 78.75295  62  89 72.50 74.5 76.00
PL   81.2 6.828047 10 2.024022 77.04705 85.35295  69  90 77.50 79.5 87.75

$comparison
NULL

$groups
       y2 groups
PL   81.2      a
PjBL 74.6      b
PBL  74.3      b

attr(,"class")
[1] "group"
Hasil Interpretasi Uji Post Hoc
Uji Pos Hoc dengan Uji Tukey
Berdasarkan hasil Uji Post Hoc dengan menggunakan Uji Tukey untuk mengetahui perbedaan pengaruh Model pembelajaran antara PL, PBL, dan PJBL jika ditinjau dari Kemampuan pemecahan Masalah (Y1) dan Kemampuan berfikir Kritis (Y2) dengan hasil uji sebagai berikut :
1. Tidak terdapat perbedaan yang signifikan penerapan Model Pembelajaran antara Projeck Based Learning dengan Problem Based Learning ditinjau dari kemampuan Pemecahan Masalah siswa (Y1). Hal ini dapat dilihat dari nilai P-value (0.4051)>(0.05).
1. Tidak terdapat perbedaan yang signifikan penerapan Model Pembelajaran antara Posed Learning dengan Problem Based Learning ditinjau dari kemampuan Pemecahan Masalah siswa (Y1). Hal ini dapat dilihat dari nilai P-value (0.2583)>(0.05).
1. Terdapat perbedaan yang signifikan penerapan Model Pembelajaran antara Posed Learning dengan Project Based Learning ditinjau dari kemampuan Pemecahan Masalah siswa (Y1). Hal ini dapat dilihat dari nilai P-value (0.0187)<(0.05).
1. Tidak terdapat perbedaan yang signifikan penerapan Model Pembelajaran antara Projeck Based Learning dengan Problem Based Learning ditinjau dari kemampuan Berpikir Kritis (Y2) PjBL dengan PBL. Hal ini dapat dilihat dari nilai P-value (0.9939)>(0.05).
1. Tidak terdapat perbedaan yang signifikan penerapan Model Pembelajaran antara Posed Learning dengan Problem Based Learning ditinjau dari Kemampuan Berpikir Kritis Siswa (Y2) . Hal ini dapat dilihat dari nilai P-value (0.057)>(0.05).
1. Terdapat perbedaan yang signifikan penerapan Model Pembelajaran antara Posed Learning dengan Project Based Learning ditinjau dari kemampuan Berpikir Kritis (Y2). Hal ini dapat dilihat dari nilai P-value (0.0720)>(0.05).
Interval Kepercayaan
1. Kemampuan Pemecahan Masalah (Y1) Interval Kepercayaan hasil Uji Pasangan antara Model Pembelajaran PL dengan PBL, PL dengan PjBL, dan PBL dengan PjBL ditinjau dari kemampuan Pemecahan Masalah siswa dapat dilihat dari hasil uji Tukey sebagai berikut
[1] "Ini Hasil Uji Tukey Y1, untuk Interval Kepercayaan pada Kolom lwr dan upr"
         diff       lwr       upr      p adj
PjBL-PBL -3.4 -9.863769  3.063769 0.40513351
PL-PBL    4.2 -2.263769 10.663769 0.25834688
PL-PjBL   7.6  1.136231 14.063769 0.01874647
· Model PjBL dan PBL berdasarkan hasil yang diperoleh perbedaan rata-rata PjBL dan PBL = -3.4 berada pada interval -9.863 < 3,4 < 3.064, Maka  diterima, artinya tidak terdapat perbedaan rata-rata Model PjBL dengan PBL ditinjau dari Kemempuan Pemecahan Masalah.
· Model PL dan PBL berdasarkan hasil yang diperoleh perbedaan rata-rata PL dan PBL = 4.2 berada pada interval, -2.264 < 4.2 < 10.664, Maka  diterima, artinya tidak terdapat perbedaan rata-rata Model PL dengan PBL ditinjau dari Kemempuan Pemecahan Masalah.
· Model PL dan PjBL berdasarkan hasil yang diperoleh perbedaan rata-rata PL dan PBL = 4.2 berada pada interval, 1.136 < 7.6 < 14.064, Maka  ditolak, artinya terdapat perbedaan yang meyakinkan rata-rata Model PL dengan PBL ditinjau dari Kemempuan Pemecahan Masalah.
1. Kemampuan berfikir Kritis (Y2) Interval Kepercayaan hasil Uji Pasangan antara Model Pembelajaran PL dengan PBL, PL dengan PjBL, dan PBL dengan PjBL ditinjau dari kemampuan berfikir Kritis siswa dapat dilihat dari hasil uji Tukey sebagai berikut
[1] "Ini Hasil Uji Tukey Y2, untuk Interval Kepercayaan pada Kolom lwr dan upr"
         diff       lwr       upr      p adj
PjBL-PBL  0.3 -6.797085  7.397085 0.99396371
PL-PBL    6.9 -0.197085 13.997085 0.05790862
PL-PjBL   6.6 -0.497085 13.697085 0.07206492
· Model PjBL dan PBL berdasarkan hasil yang diperoleh perbedaan rata-rata PjBL dan PBL = 0.3 berada pada interval -6.797 < 0.3 < 7.397, Maka  diterima, artinya tidak terdapat perbedaan rata-rata Model PjBL dengan PBL ditinjau dari Kemampuan Berpikir Kritis
· Model PL dan PBL berdasarkan hasil yang diperoleh perbedaan rata-rata PL dan PBL = 6.9 berada pada interval, -0.197 < 6.9 < 13.997, Maka  diterima, artinya tidak terdapat perbedaan rata-rata Model PL dengan PBL ditinjau dari Kemampuan Berpikir Kritis.
· Model PL dan PjBL berdasarkan hasil yang diperoleh perbedaan rata-rata PL dan PBL = 6.6 berada pada interval, -0.497 < 6.6 < 13.697, Maka  ditolak, artinya terdapat perbedaan yang meyakinkan rata-rata Model PL dengan PBL ditinjau dari Kemampuan Berpikir Kritis.
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